Chapter 106

Conditional Power and Sample Size

Reestimation of Non-Inferiority Tests for One Proportion

Introduction

In sequential designs, one or more intermediate analyses of the emerging data are conducted to evaluate whether the experiment should be continued. This may be done to conserve resources or to allow a data monitoring board to evaluate safety and efficacy when subjects are entered in a staggered fashion over a long period of time. Conditional power (a frequentist concept) is the probability that the final result will be significant, given the data obtained up to the time of the interim look. Predictive power (a Bayesian concept) is the result of averaging the conditional power over the posterior distribution of effect size. Both of these methods fall under the heading of stochastic curtailment techniques. Further reading about the theory of these methods can be found in Jennison and Turnbull (2000), Chow and Chang (2007), Chang (2008), Proschan et. al (2006), and Dmitrienko et. al (2005).

This program module computes conditional and predicted power for the case when a one-sample z-test is used to test whether a population proportion is greater than or less than a specific non-inferiority bound. It also provides sample size reestimation to achieve a specified conditional power value.

Technical Details

All details and assumptions usually made when using a one-sample non-inferiority z-test continue to be in force here.

Conditional Power

The power of an experiment indicates whether a study is likely to result in useful results, given the sample size. Low power means that the study is futile: little chance of statistical significance even though the alternative hypothesis is true. A study that is futile should not be started. However, futility may be determined only after the study has started. When this happens, the study is curtailed.

The futility of a study that is underway can be determined by calculating its conditional power: the probability of statistical significance at the completion of the study given the data obtained so far.
It is important to note that conditional power at the beginning of the study before any data are collected is equal to the unconditional power. So, conditional power will be high even if early results are negative. Hence, conditional power will seldom result in study curtailment very early in the study.

From Jennison and Turnbull (2000) pages 205 to 208, the general upper one-sided conditional power at stage $k$ for rejecting a null hypothesis about a parameter $\theta$ at the end of the study, given the observed test statistic, $Z_k$, is computed as

$$P_{un} (\theta) = \Phi \left( \frac{Z_k \sqrt{I_k} - z_{1-\alpha} \sqrt{I_K} + \theta (I_K - I_k)}{\sqrt{I_K - I_k}} \right),$$

and the general lower one-sided conditional power at stage $k$ is computed as

$$P_{lk} (\theta) = \Phi \left( \frac{-Z_k \sqrt{I_k} - z_{1-\alpha} \sqrt{I_K} - \theta (I_K - I_k)}{\sqrt{I_K - I_k}} \right),$$

where

- $\theta$ = the parameter being tested by the hypothesis
- $k$ = an interim stage at which the conditional power is computed ($k = 1, \ldots, K - 1$)
- $K$ = the stage at which the study is terminated and the final test computed
- $Z_k$ = the test statistic calculated from the observed data that has been collected up to stage $k$
- $I_k$ = the information level at stage $k$
- $I_K$ = the information level at the end of the study
- $z_{1-\alpha}$ = the standard normal value for the test with a type I error rate of $\alpha$.

If we define $P_s$ as the population reference, standard, or baseline proportion, $NIM$ as the non-inferiority margin, and $P_A$ as the actual proportion under the alternative hypothesis, then the parameter $\theta$ to test the one-sided non-inferiority alternative hypotheses of $H_1: P > P_0$ (higher proportions better with $P_0 = P_s - |NIM|$) or $H_1: P < P_0$ (higher proportions worse with $P_0 = P_s + |NIM|$) and other conditional power calculation components as outlined in Chang (2008) page 70 are

- $\theta = P_A - P_0$ (the expected difference under the alternative hypothesis)
- $Z_k = (p_k - P_0) \sqrt{\hat{I}_k}$ (the $z$-statistic computed from the observed data)
- $I_k = n_k / \sigma^2$ (the interim information level)
- $I_K = N / \sigma^2$ (the final information level)

where

- $p_k$ is the sample proportion, estimating $P_A$ at stage $k$
- $\hat{I}_k$ is the estimated information from the sample at stage $k$
- $n_k$ is the sample size at stage $k$
- $N$ is the total sample size
- $\sigma^2 = \bar{p}(1 - \bar{p})$ with $\bar{p} = (P_s + P_0) / 2$. 

$$
\sigma^2 = \bar{p}(1 - \bar{p}) \text{ with } \bar{p} = \frac{P_s + P_0}{2}.
$$
Computing conditional power requires you to set $P_0$ and $P_1$. Their values can come from the values used during the planning of the study, from similar studies, or from estimates made from the data that has emerged.

**Futility Index**

The *futility index* is $1 - P_k(\theta)|H_1$. The study may be stopped if this index is above 0.8 or 0.9 (that is, if conditional power falls below 0.2 or 0.1).

**Predictive Power**

*Predictive power* (a Bayesian concept) is the result of averaging the conditional power over the posterior distribution of effect size. From Jennison and Turnbull (2000) pages 210 to 213, the general upper one-sided predictive power at stage $k$ is given by

$$P_{uk} = \Phi \left( \frac{Z_k \sqrt{I_K} - z_{1-\alpha} \sqrt{I_k}}{\sqrt{I_K - I_k}} \right),$$

and the general lower one-sided predictive power at stage $k$ is given by

$$P_{lk} = \Phi \left( -\frac{Z_k \sqrt{I_K} - z_{1-\alpha} \sqrt{I_k}}{\sqrt{I_K - I_k}} \right),$$

with all terms defined as in the equations for conditional power.

**Sample Size Reestimation**

As Chang (2014) points out, after an interim analysis, it is often desirable to recalculate the target sample size using updated values for various nuisance parameters such as the variance. This process is known as *sample size reestimation*.

One method of calculating an adjusted sample size estimate is to search for the sample size that results in a predetermined value of conditional power. PASS conducts a binary search using the conditional power as the criterion. The result is called the *target sample size*. 
Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains most of the parameters and options that you will be concerned with.

Solve For

This option specifies the parameter to be solved for from the other parameters. The parameters that may be selected are Conditional Power or Sample Size Reestimation.

Note that the value selected here always appears as the vertical axis on the charts.

The program is set up to calculate conditional power directly. To find appropriate values of sample size, a binary search is made using an iterative procedure until an appropriate value is found.

Test

Higher Proportions Are

Use this option to specify the direction of the non-inferiority test.

If Higher Proportions are “Better”, the alternative hypothesis is H1: P > P0.

If Higher Proportions are “Worse”, the alternative hypothesis is H1: P < P0.

Conditional Power and Alpha

Conditional Power

Enter one or more values for the conditional power that is to be attained by the sample size search.

*Conditional power* is the probability of rejecting a false null hypothesis given the data that has been obtained so far. It is a function of the effect size and the data that have been collected.

The valid range is between 0 to 1. Typically, values over 0.70 are considered high enough to continue a study, while values below 0.10 considered grounds for curtailing the study.

You can enter a single value such as 0.80 or a series of values such as 0.80 0.85 0.90 0.95 or 0.7 to 0.97 by 0.05.

Alpha

This option specifies one or more values for the probability of a type-I error at the end of the study. A type-I error occurs when a true null hypothesis is rejected.

Values must be between zero and one. Historically, the value of 0.05 has been used for two-sided tests and 0.025 for one-sided tests.

You may enter a single value or a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
Sample Size

N (Target Sample Size)
This option specifies one or more values of the target sample size, the total number of subjects planned for the study. This value must be an integer greater than one. Note that you may enter a list of values using the syntax 50,100,150,200,250 or 50 to 250 by 50.

nk (Sample Size at Look k)
Enter the sample size obtained through look k. If this value is greater than N, the value of N is increased to this amount.

Effect Size – Proportions

P0 (Non-Inferiority Proportion)
This is the bound of the non-inferiority test hypothesis.

If NIM is the non-inferiority margin and Ps is the reference, standard, or baseline proportion, then when Higher Proportions are “Better”, the alternative hypothesis is H1: P > P0, with P0 = Ps - |NIM| and P0 < P1. When Higher Proportions are “Worse”, the alternative hypothesis is H1: P < P0, with P0 = Ps + |NIM| and P0 > P1.

P1 (Actual Proportion to Detect)
This is the actual proportion at which conditional power is calculated. Care should be taken that this value is consistent with the alternative hypothesis.

When Higher Proportions are “Better”, P1 > P0. When Higher Proportions are “Worse”, P1 < P0.

Effect Size – Current Test Statistic

Zk (Current Test Statistic)
Enter the value of the z-statistic calculated from the data obtained through stage k. This value may be positive or negative. Typically, the z-statistic ranges between -5 and 5.
Example 1 – Computing Conditional Power

Suppose a study has been planned and is to be analyzed using a one-sided non-inferiority z-test at an alpha of 0.025. The reference proportion is known to be 0.6 and the test will have a non-inferiority margin of 0.05. The test will have a lower bound of $P_0 = P_s - \text{NIM} = 0.6 - 0.05 = 0.55$. They would like to compute conditional power for an actual proportion of $P_1 = 0.65$. The sample size is 50. An interim analysis will be run after half the data have been collected.

The data monitoring board would like to have the conditional power calculated for z-values of 1.0, 1.5, 2.0, 2.5, and 3.0.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may make the appropriate entries as listed below or open Example 1 by going to the File menu and choosing Open Example Template.

Option Value
Design Tab
Solve For ................................................ Conditional Power
Higher Proportions Are ............................... Better (H1: P > P0)
Alpha ....................................................... 0.025
N (Target Sample Size) .................. 50
nk (Sample Size at Look k) .................. 25
$P_0$ (Non-Inferiority Proportion) .......... 0.55
$P_1$ (Actual Proportion to Detect) ......... 0.65
Zk (Current Test Statistic) ................. 1 1.5 2 2.5 3

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

*References*


**Report Definitions**

Conditional Power is the probability of rejecting a false null hypothesis at the end of the study given the data that have emerged so far.

Predictive Power is the result of averaging the conditional power over the posterior distribution of the effect size.

N is the target sample size.

nk is the sample size obtained through stage k.

P0 is the non-inferiority proportion used to construct the hypotheses.

P1 is the actual proportion to detect under the alternative hypothesis at which conditional power is calculated.

P1-P0 is the proportion difference that is to be detected by the completed study.

Zk is the value of the test statistic from the observed data at stage k.

Alpha is the probability of rejecting a true null hypothesis.

Futility is one minus the conditional power. A value greater than 0.9 or 0.8 indicates the study should be stopped because there is little chance of achieving statistical significance.

**Summary Statements**

The first 25 of the planned 50 subjects achieve 22.627% conditional power to detect a difference of P1 - P0 = 0.100 using a non-inferiority z-test with a bound of μ0 = 0.550, an actual proportion of μ1 = 0.650, and a significance level of 0.025. The z-value of the data that have emerged so far is 1.000. The futility index is 0.77373.

This report shows the values of each of the parameters, one scenario per row. The definitions of each column are given in the Report Definitions section.

**Plots Section**

This plot shows the relationship between conditional power and Zk.
Example 2 – Validation

We could not find an example of a conditional power calculation for a one-sample non-inferiority test in the literature. Since the calculations are relatively simple, we will validate the calculation of the third scenario of Example 1 (Zk = 2) by hand.

In this case

\[ I_k = \frac{n_k}{\sigma^2} \quad I_K = \frac{N}{\sigma^2} \]

\[ = \frac{25}{0.6(1 - 0.6)} = \frac{50}{0.6(1 - 0.6)} \]

\[ = \frac{104.1666667}{208.3333333} \]

\[ P_{nk}(\theta) = \Phi \left( \frac{Z_k \sqrt{I_k} - z_{1-\alpha} \sqrt{I_K} + \theta (I_K - I_k)}{\sqrt{I_K - I_k}} \right) \]

\[ = \Phi \left( \frac{2.0\sqrt{104.1666667} - 1.9599964\sqrt{208.3333333} + (0.65 - 0.55)(208.3333333 - 104.1666667)}{\sqrt{208.3333333 - 104.1666667}} \right) \]

\[ = \Phi \left( \frac{2.5394376}{10.2062073} \right) \]

\[ = \Phi (0.2488131) \]

\[ = 0.5982473 \]

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may make the appropriate entries as listed below or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Conditional Power</td>
</tr>
<tr>
<td>Higher Proportions Are</td>
<td>Better (H1: P &gt; P0)</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.025</td>
</tr>
<tr>
<td>N (Target Sample Size)</td>
<td>50</td>
</tr>
<tr>
<td>nk (Sample Size at Look k)</td>
<td>25</td>
</tr>
<tr>
<td>P0 (Non-Inferiority Proportion)</td>
<td>0.55</td>
</tr>
<tr>
<td>P1 (Actual Proportion to Detect)</td>
<td>0.65</td>
</tr>
<tr>
<td>Zk (Current Test Statistic)</td>
<td>2</td>
</tr>
</tbody>
</table>
Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Cond. Power</th>
<th>Pred. Power</th>
<th>Sample Size N</th>
<th>Current Sample Size nk</th>
<th>Non-Inf Prop P0</th>
<th>Actual Prop P1</th>
<th>Diff P1-P0</th>
<th>Test Statistic Zk</th>
<th>Alpha</th>
<th>Futility</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.59825</td>
<td>0.80743</td>
<td>50</td>
<td>25</td>
<td>0.550</td>
<td>0.650</td>
<td>0.100</td>
<td>2.000</td>
<td>0.025</td>
<td>0.40175</td>
</tr>
</tbody>
</table>

The conditional power of 0.59825 matches the value calculated by hand.
Example 3 – Sample Size Reestimation

Suppose a study has started that is to be analyzed using a one-sided non-inferiority $z$-test at an alpha of 0.025. The reference proportion was set at 0.6 and the non-inferiority margin was set at 0.05. The target sample size was 50.

An interim analysis was run after half the data had been collected. This analysis yielded a $z$-test value of 2.12. The value of the baseline proportion was estimated at 0.637, so we set $P_0$ to 0.637 – 0.05 = 0.587.

The data monitoring board would like to have the sample size reestimated for an actual difference of $\delta_1 = 0.1$ ($P_1 = 0.687$) and a conditional power of 0.8.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the procedure window. You may make the appropriate entries as listed below or open Example 3 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td>Sample Size Reestimation</td>
</tr>
<tr>
<td>Solve For</td>
<td>Better ($H_1: P &gt; P_0$)</td>
</tr>
<tr>
<td>Higher Proportions Are</td>
<td>0.8</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.025</td>
</tr>
<tr>
<td>nk (Sample Size at Look k)</td>
<td>25</td>
</tr>
<tr>
<td>$P_0$ (Non-Inferiority Proportion)</td>
<td>0.587</td>
</tr>
<tr>
<td>$P_1$ (Actual Proportion to Detect)</td>
<td>0.687</td>
</tr>
<tr>
<td>$Z_k$ (Current Test Statistic)</td>
<td>2.12</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Cond. Power</th>
<th>Pred. Power</th>
<th>Target Sample Size</th>
<th>Current Sample Size</th>
<th>Non-Inf Prop P0</th>
<th>Actual Prop P1</th>
<th>Diff P1-P0</th>
<th>Test Statistic</th>
<th>Alpha</th>
<th>Futility</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.80091</td>
<td>0.91177</td>
<td>111</td>
<td>25</td>
<td>0.587</td>
<td>0.687</td>
<td>0.100</td>
<td>2.120</td>
<td>0.025</td>
<td>0.19909</td>
</tr>
</tbody>
</table>

Notice that the target sample size has increased from 50 to 111.